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Keyboard shortcuts in Windows

Select Product Version

Windows 10 v

Windows 10

Keyboard shortcuts are keys or combinations of keys that provide an alternative way to do
something that you'd typically do with a mouse.

Additional keyboard shortcuts

Keyboard shortcuts in apps

Windows keyboard shortcuts for accessibility

Microsoft Surface Hub keyboard shortcuts

Keyboard shortcuts in Continuum for phones

Copy, paste, and other general keyboard shortcuts

Press this key To do this

Ctrl + X Cut the selected item

Ctrl + C (or Ctrl + Insert) Copy the selected item

Ctrl + V (or Shift + Insert) Paste the selected item

Ctrl + Z Undo an action

Alt + Tab Switch between open apps

Alt + F4 Close the active item, or exit the active app

Windows logo key & + L Lock your PC
Windows logo key %8 + D Display and hide the desktop

F2 Rename the selected item
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F3

F4

F5

F6

F10

Alt + F8

Alt + Esc

Alt + underlined letter

Alt + Enter

Alt + Spacebar
Alt + Left arrow
Alt + Right arrow
Alt + Page Up
Alt + Page Down

Ctrl + F4

Ctrl + A

Ctrl + D (or Delete)
Ctrl + R (or F5)
Ctrl +Y

Ctrl + Right arrow
Ctrl + Left arrow
Ctrl + Down arrow

Ctrl + Up arrow

Keyboard shortcuts in Windows - Windows Help

Search for a file or folder in File Explorer

Display the address bar list in File Explorer

Refresh the active window

Cycle through screen elements in a window or on the desktop
Activate the Menu bar in the active app

Show your password on the sign-in screen

Cycle through items in the order in which they were opened
Perform the command for that letter

Display properties for the selected item

Open the shortcut menu for the active window

Go back

Go forward

Move up one screen

Move down one screen

Close the active document (in apps that are full-screen and let you
have multiple documents open at the same time)

Select all items in a document or window

Delete the selected item and move it to the Recycle Bin
Refresh the active window

Redo an action

Move the cursor to the beginning of the next word
Move the cursor to the beginning of the previous word
Move the cursor to the beginning of the next paragraph

Move the cursor to the beginning of the previous paragraph
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Ctrl + Alt + Tab

Ctrl + Alt + Shift + arrow
keys

Ctrl + arrow key (to move
to an item) + Spacebar

Ctrl + Shift with an arrow
key

Ctrl + Esc
Ctrl + Shift + Esc

Ctrl + Shift

Ctrl + Spacebar
Shift + F10

Shift with any arrow key

Shift + Delete
Right arrow
Left arrow

Esc

Keyboard shortcuts in Windows - Windows Help

Use the arrow keys to switch between all open apps

When a group or tile is in focus on the Start menu, move it in the
direction specified

Select multiple individual items in a window or on the desktop

Select a block of text

Open Start
Open Task Manager

Switch the keyboard layout when multiple keyboard layouts are
available

Turn the Chinese input method editor (IME) on or off
Display the shortcut menu for the selected item

Select more than one item in a window or on the desktop, or
select text in a document

Delete the selected item without moving it to the Recycle Bin first
Open the next menu to the right, or open a submenu
Open the next menu to the left, or close a submenu

Stop or leave the current task

Windows logo key keyboard shortcuts

Press this key

Windows logo
key ==

Windows logo
key o& + A

Windows logo
key == + B

To do this

Open or close Start

Open Action center

Set focus in the notification area

https://support.microsoft.com/en-au/help/12445/windows-keyboard-shortcuts
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Windows logo
key 38 + C

Windows logo
key =& + Shift + C

Windows logo
key =& + D

Windows logo
key 38 + Alt + D

Windows logo
key == + E

Windows logo
key =@ + F

Windows logo
key T& + G

Windows logo
key %@ + H

Windows logo

key 98 + |

Windows logo
key 38 + )

Windows logo
key =& + K

Windows logo
key =3 + L

Windows loao

Keyboard shortcuts in Windows - Windows Help

Open Cortana in listening mode

Notes

e This shortcut is turned off by default. To turn it on, select Start s >
Settings % > Cortana, and turn on the toggle under Let Cortana
listen for my commands when | press the Windows logo key +
C

e Cortana is available only in certain countries/regions, and some
Cortana features might not be available everywhere. If Cortana isn't
available or is turned off, you can still use search.

Open the charms menu

Display and hide the desktop

Display and hide the date and time on the desktop

Open File Explorer

Open Feedback Hub and take a screenshot

Open Game bar when a game is open

Start dictation

Open Settings

Set focus to a Windows tip when one is available.

When a Windows tip appears, bring focus to the Tip. Pressing the
keyboard shortcuts again to bring focus to the element on the screen to
which the Windows tip is anchored.

Open the Connect quick action

Lock your PC or switch accounts

Minimize all windows

https://support.microsoft.com/en-au/help/12445/windows-keyboard-shortcuts
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key 2@ + M

Windows logo Lock device orientation

key =& + O

Windows logo Choose a presentation display mode
key =& + P

Windows logo Open the Run dialog box

key 2@ + R

Windows logo Open search

key 5@ + S

Windows logo Cycle through apps on the taskbar
key @ + T

Windows logo Open Ease of Access Center

key %8 + U

Windows logo Cycle through notifications

key =@ + V

Windows logo Cycle through notifications in reverse order

key =& + Shift + V

Windows logo Open the Quick Link menu
key =@ + X

Windows logo key  Switch input between Windows Mixed Reality and your desktop
1]
um + Y

Windows logo Show the commands available in an app in full-screen mode
key %) + Z

Windows logo key ~ Open emoji panel
a3 + period () or
semicolon (;)

Windows logo Temporarily peek at the desktop
key %8 + comma

()

Windows logo Display the System Properties dialog box
key =& + Pause

Windows logo Search for PCs (if you're on a network)
key 2@ + Ctrl + F
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Windows logo

key 2@ + Shift + M

Windows logo
key 38 + number

Windows logo
key 28 + Shift +
number

Windows logo
key =& + Ctrl +
number

Windows logo
key 5@ + Alt +
number

Windows logo
key =& + Ctrl +
Shift + number

Windows logo
key =& + Tab

Windows logo

key =& + Up arrow

Windows logo
key 38 + Down
arrow

Windows logo
key 5@ + Left
arrow

Windows logo
key 38 + Right
arrow

Windows logo
key 2@ + Home

Windows logo
key 38 + Shift +
Up arrow

Windows logo
key 38 + Shift +
Down arrow

Keyboard shortcuts in Windows - Windows Help

Restore minimized windows on the desktop

Open the desktop and start the app pinned to the taskbar in the position
indicated by the number. If the app is already running, switch to that app.
Open the desktop and start a new instance of the app pinned to the

taskbar in the position indicated by the number

Open the desktop and switch to the last active window of the app pinned
to the taskbar in the position indicated by the number

Open the desktop and open the Jump List for the app pinned to the
taskbar in the position indicated by the number

Open the desktop and open a new instance of the app located at the given
position on the taskbar as an administrator

Open Task view

Maximize the window

Remove current app from screen or minimize the desktop window

Maximize the app or desktop window to the left side of the screen

Maximize the app or desktop window to the right side of the screen

Minimize all except the active desktop window (restores all windows on
second stroke)

Stretch the desktop window to the top and bottom of the screen

Restore/minimize active desktop windows vertically, maintaining width
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Windows logo Move an app or window in the desktop from one monitor to another
key 38 + Shift +

Left arrow or

Right arrow

Windows logo Switch input language and keyboard layout
key =& + Spacebar

Windows logo Change to a previously selected input
key 38 + Ctrl +
Spacebar

Windows logo Open Narrator
key 38 + Ctrl +
Enter

Windows logo Begin IME reconversion
key =& + forward
slash (/)

Windows logo key  Open shoulder taps
a= + Ctrl +V

Command Prompt keyboard shortcuts

Press this key To do this

Ctrl + C (or Ctrl ~ Copy the selected text
+ Insert)

Ctrl + V (or Paste the selected text
Shift + Insert)

Ctrl + M Enter Mark mode

Alt + selection Begin selection in block mode

key

Arrow keys Move the cursor in the direction specified
Page up Move the cursor by one page up

Page down Move the cursor by one page down

Ctrl + Home Move the cursor to the beginning of the buffer

(Mark mode)
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Ctrl + End
(Mark mode)

Ctrl + Up
arrow

Ctrl + Down
arrow

Ctrl + Home
(History
navigation) line.

Ctrl + End
(History
navigation) line.

Keyboard shortcuts in Windows - Windows Help

Move the cursor to the end of the buffer

Move up one line in the output history

Move down one line in the output history

If the command line is empty, move the viewport to the top of the buffer.
Otherwise, delete all the characters to the left of the cursor in the command

If the command line is empty, move the viewport to the command line.
Otherwise, delete all the characters to the right of the cursor in the command

Dialog box keyboard shortcuts

Press this key
F4

Ctrl + Tab

Ctrl + Shift + Tab

Ctrl + number (number
1-9)

Tab
Shift + Tab

Alt + underlined letter

Spacebar

Backspace

Arrow keys

To do this
Display the items in the active list
Move forward through tabs
Move back through tabs

Move to nth tab

Move forward through options
Move back through options

Perform the command (or select the option) that is used with that
letter

Select or clear the check box if the active option is a check box

Open a folder one level up if a folder is selected in the Save As or
Open dialog box

Select a button if the active option is a group of option buttons

https://support.microsoft.com/en-au/help/12445/windows-keyboard-shortcuts
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Keyboard shortcuts in Windows - Windows Help

File Explorer keyboard shortcuts

Press this key
Alt + D
Ctrl + E
Ctrl + F
Ctrl + N
Ctrl + W

Ctrl + mouse scroll
wheel

Ctrl + Shift + E
Ctrl + Shift + N

Num Lock + asterisk

*)

Num Lock + plus

(+)

Num Lock + minus

Q)

Alt + P

Alt + Enter

Alt + Right arrow
Alt + Up arrow
Alt + Left arrow
Backspace

Right arrow

Left arrow

To do this
Select the address bar
Select the search box
Select the search box
Open a new window
Close the active window

Change the size and appearance of file and folder icons

Display all folders above the selected folder
Create a new folder

Display all subfolders under the selected folder

Display the contents of the selected folder

Collapse the selected folder

Display the preview panel

Open the Properties dialog box for the selected item

View the next folder

View the folder that the folder was in

View the previous folder

View the previous folder

Display the current selection (if it's collapsed), or select the first subfolder

Collapse the current selection (if it's expanded), or select the folder that
the folder was in
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End Display the bottom of the active window
Home Display the top of the active window
F11 Maximize or minimize the active window

Virtual desktops keyboard shortcuts

Press this key To do this

Windows logo key & + Tab Open Task view

Windows logo key 28 + Ctrl + D Add a virtual desktop

Windows logo key & + Ctrl + Right Switch between virtual desktops you've created on the
arrow right

Windows logo key 38 + Ctrl + Left Switch between virtual desktops you've created on the
arrow left

Windows logo key 8 + Ctrl + F4 Close the virtual desktop you're using

Taskbar keyboard shortcuts

Press this key To do this

Shift + click a taskbar button Open an app or quickly open another instance of an
app

Ctrl + Shift + click a taskbar button Open an app as an administrator

Shift + right-click a taskbar button Show the window menu for the app

Shift + right-click a grouped taskbar Show the window menu for the group

button

Ctrl + click a grouped taskbar button Cycle through the windows of the group

Settings keyboard shortcuts
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Press this key To do this
Windows logo key 23 + | Open settings
Backspace Go back to the settings home page
Type on any page with search box Search settings
Properties

Article ID: 12445 - Last Review: 18 Oct 2017 - Revision: 137

Applies to
Windows 10, Windows 8.1, Windows 7
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Keyboard shortcuts for Microsoft
Word on Windows

Applies To: Word 2016, Word 2013, Word 2010, Word 2007, Word Starter 2010

This article shows all keyboard shortcuts for Microsoft Word. For users with mobility or
vision disabilities, keyboard shortcuts can be easier than using the touchscreen and are an
essential alternative to using a mouse. This article itemizes the keyboard shortcuts for Word
on Windows.

Get these keyboard shortcuts in a Word document at this link: Word 2016 for Windows
keyboard shortcuts.

NOTES:

®  The shortcuts in this topic refer to the US keyboard layout. Keys for other layouts might not correspond
exactly to the keys on a US keyboard.

®  Commands that require you to press and release multiple keys together are indicated with a plus sign
(+). Commands that require you to press multiple keys in order are indicated by a comma sign (,).

2016, 2013 2010, 2007

In this topic

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-95EF89DD-7 142-4B50-AFB2-F762F663CEB2?ui=en-...  1/8
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Frequently used shortcuts
Use the keyboard to move around the ribbon
Keyboard shortcut reference for Microsoft Word

Function key reference

Frequently used shortcuts

This table shows the most frequently used shortcuts in Microsoft Word.

To do this Press

Go to "Tell me what you want to  Alt+Q

do"

Open Ctrl+O
Save Ctrl+S

Close Ctrl+W
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Select all Ctrl+A
Bold Ctrl+B

Italic Ctrl+1

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-95EF89DD-7142-4B50-AFB2-F762F663CEB2?ui=en-... 2/8
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To do this Press
Underline Ctrl+U
Decrease font size 1 point Ctrl+[
Increase font size 1 point Ctrl+]
Center text Ctrl+E
Left align text Ctrl+L
Right align text Ctrl+R
Cancel Esc
Undo Ctrl+Z
Re-do Ctrl+Y
Zoom Alt+W, Q, then tab in Zoom dialog box to the value
you want.

Use the keyboard to move around the ribbon

The ribbon is the strip at the top of Word, organized by tabs. Each tab displays a different
ribbon. Ribbons are made up of groups, and each group includes one or more commands.
You can access every command in Word by using a shortcut.

NOTE: Add-ins and other programs may add new tabs to the ribbon and may provide access keys for those
tabs.

There are two ways to move through the tabs in the ribbon:

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-95EF89DD-7 142-4B50-AFB2-F762F663CEB2?ui=en-...  3/8
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= To go to the ribbon, press Alt, and then, to move between tabs, use the Right Arrow and
Left Arrow keys.

= To go directly to a specific tab on the ribbon, use one of the access keys.

Use the access keys %
Use commands on a ribbon by using the keyboard %
Use access keys when you can see the KeyTips %
Change focus by using the keyboard instead of a mouse %

Keyboard shortcut reference for Microsoft Word

Create and edit documents

Create, view, and save documents v
Work with Web content %
Print and preview documents %
Check spelling and review changes in a document %
Find, replace, and go to specific items in the document %
Use the keyboard to move around in a document %
Insert or mark Table of Contents, footnotes, and citations %

Work with documents in different views

Word offers several different views of a document. Each view makes it easier to do certain
tasks. For example, Read Mode enables you to present two pages of the document side by
side, and to use an arrow to move to the next page.

Switch to another view of the document v
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Work with headings in Outline view %

Move through the document in Read Mode view %

Edit and move text and graphics

Select text and graphics v
Extend a selection v
Delete text and graphics v
Copy and move text and graphics v

Edit and move through tables

Select text and graphics in a table %
Move within a table %
Insert paragraphs and tab characters in a table %

Format characters and paragraphs

Format characters %
Change or resize the font %
Copy formatting %
Change paragraph alignment %
Copy and review text formats %
Set line spacing %
Apply styles to paragraphs %
Insert special characters %
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Insert characters by using character codes %

Insert and edit objects

Insert an object NV
Edit an object NV
Insert SmartArt graphics v
Insert WordArt v

Mail merge and fields

NOTE: You must press Alt+M, or click Mailings, to use these keyboard shortcuts.
Perform a mail merge v

Work with fields v

Language Bar

Set proofing language v

Turn on East Asian Input Method Editors v

Function key reference

Function keys %
Shift+Function keys v
Ctrl+Function keys v
Ctrl+Shift+Function keys v
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Alt+Function keys %

Alt+Shift+Function keys %

Ctrl+Alt+Function keys %
See also

Learn how to navigate Word using accessible features

Basic tasks using a screen reader with Word

Technical support for customers with disabilities

Microsoft wants to provide the best possible experience for all our customers. If you have a
disability or questions related to accessibility, please contact the Microsoft Disability
Answer Desk for technical assistance. The Disability Answer Desk support team is trained in
using many popular assistive technologies and can offer assistance in English, Spanish,
French, and American Sign Language. Please go to the Microsoft Disability Answer Desk
site to find out the contact details for your region.

If you are a government, commercial, or enterprise user, please contact the enterprise
Disability Answer Desk.

£ Jin IS

Connect with an expert
CONTACT US >

Expand your skills
EXPLORE TRAINING >

Was this information helpful? Yes No
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Excel keyboard shortcuts and ==
function keys tor Windows

Applies To: Excel 2016, Excel 2013, Excel 2010, Excel 2007

Many users find that using an external keyboard with keyboard shortcuts for Excel 2016 on
Windows helps them work more efficiently. For users with mobility or vision disabilities,
keyboard shortcuts can be easier than using the touchscreen and are an essential
alternative to using a mouse. This article itemizes the keyboard shortcuts for Excel 2016 on
Windows.

NOTES:

B The shortcuts in this topic refer to the US keyboard layout. Keys for other layouts might not correspond
exactly to the keys on a US keyboard.

®  |f a shortcut requires pressing two or more keys at the same time, this topic separates the keys with a
plus sign (+). If you have to press one key immediately after another, the keys are separated by a
comma (,).

2016 2013 2010 2007

This article describes keyboard shortcuts, function keys, and some other common shortcut
keys for Excel 2016. This includes the access keys that you can use for ribbon commands.
For Excel Online, see Keyboard shortcuts in Excel Online.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...
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NOTES:

®  To keep this reference available when you work, you may want to print this topic. To print this topic,
press Ctrl+P.

®m  To see an online workbook with this information, check out our workbook on Docs.com. This workbook
lets you scroll, sort, and filter for any key combination. And, you can also download it.

®  Get these keyboard shortcuts in a Word document at this link: Excel 2016 for Windows keyboard
shortcuts

Frequently used shortcuts

If you're new to the Ribbon, the information in this section can help you understand the
Ribbon's keyboard shortcut model. The Ribbon comes with new shortcuts, called Key Tips,
which you can make appear when you press the Alt key. The Ribbon groups related
commands on tabs. For example, on the Home tab, the Number group includes the
Number Format command.

This table lists the most frequently used shortcuts in Excel 2016.

To do this Press
Close a workbook Ctrl+W
Open a workbook Ctrl+O
Go to the Home tab Alt+H
Save a workbook Ctrl+S
Copy Ctrl+C
Paste Ctrl+V
Undo Ctrl+Z

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e... 2/37
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To do this

Remove cell contents

Choose a fill color

Cut

Go to Insert tab

Bold

Center align cell contents

Go to Page Layout tab

Go to Data tab

Go to View tab

Open context menu

Add borders

Delete column

Go to Formula tab

Hide the selected rows

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...

Excel keyboard shortcuts and function keys for Windows - Excel

Press

Delete key

Alt+H, H

Ctrl+X

Alt+N

Ctrl+B

Alt+H, A, then C

Alt+P

Alt+A

Alt+W

Shift+F10, or

Context key

Alt+H, B

Alt+H,D, then C

Alt+M

Ctrl+9

3/37



09/11/2017 Excel keyboard shortcuts and function keys for Windows - Excel

To do this Press
Hide the selected columns Ctrl+0
Top of Page

Ribbon keyboard shortcuts

If you're new to the ribbon, the information in this section can help you understand the
ribbon's keyboard shortcut model.

When you press the Alt key, letters appear in small images, called KeyTips, next to tabs and
commands on the ribbon, as shown in the following image.

1

3] i

Home Insrﬁn Page Layout Formuias Data |!

awid [H {N] P (M) Al
| “& CO '""""}:;{,f"""":T,'"."I;_- s =1
! 43 Copy - |
: - B 0O U~ | E - A | B
1

| Clipboard . Font |

You can combine these letters with Alt to make shortcuts called Access Keys for ribbon
commands. For example, Alt+H opens the Home tab, and Alt+Q goes to the Tell me box.

Press Alt again to see KeyTips for the commands on any tab.

Access keys for ribbon tabs

To go directly to a tab on the ribbon, press one of the following access keys:

To do this Press
Open the Tell me box on the Ribbon and type a search term for Alt+Q, and
assistance or Help content. then enter the

search term.

Open the File page and use Backstage view. Alt+F

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e... 4/37
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To do this Press
Open the Home tab and format text and numbers and use the Find Alt+H
tool.

Open the Insert tab and insert PivotTables, charts, add-ins, Sparklines, Alt+N
pictures, shapes, headers, or text boxes.

Open the Page Layout tab and work with themes, page setup, scale, Alt+P
and alignment.

Open the Formulas tab and insert, trace, and customize functions and Alt+M

calculations.

Open the Data tab and connect to, sort, filter, analyze, and work with Alt+A
data.

Open the Review tab and check spelling, add comments, and protect Alt+R

sheets and workbooks.

Open the View tab and preview page breaks and layouts, show and Alt+W
hide gridlines and headings, set zoom magnification, manage windows
and panes, and view macros.

Top of Page

Work in the ribbon with the keyboard

To do this Press
Select the active tab of the ribbon, and Alt or F10. To move to a different tab, use
activate the access keys. access keys or the arrow keys.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...  5/37



09/11/2017

To do this

Move the focus to commands on the
ribbon.

Move down, up, left, or right, respectively,
among the items on the Ribbon.

Activate a selected button.

Open the list for a selected command.

Open the menu for a selected button.

When a menu or submenu is open, move to
the next command.

Expand or collapse the ribbon.

Open a context menu.

Move to the submenu when a main menu is
open or selected.

Top of Page

Excel keyboard shortcuts and function keys for Windows - Excel

Press

Tab or Shift+Tab

The Down Arrow, Up Arrow, Left Arrow, or
Right Arrow key

Spacebar or Enter

The Down Arrow key

Alt+Down Arrow

Down Arrow key

Ctrl+F1

Shift+F10
Or, on a Windows keyboard

Context key (between the right Alt and
right Ctrl keys)

Left Arrow key

Excel keyboard shortcut reference

Keyboard shortcuts for navigating in cells

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...
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To do this

Move to the previous cell in a worksheet or the previous option in a
dialog box.

Move one cell up in a worksheet.

Move one cell down in a worksheet.

Move one cell left in a worksheet.

Move one cell right in a worksheet.

Move to the edge of the current data region in a worksheet.

Enter End mode, move to the next nonblank cell in the same column
or row as the active cell, and turn off End mode. If the cells are blank,
move to the last cell in the row or column.

Move to the last cell on a worksheet, to the lowest used row of the
rightmost used column.

Extend the selection of cells to the last used cell on the worksheet
(lower-right corner).

Move to the cell in the upper-left corner of the window when Scroll
Lock is turned on.

Move to the beginning of a worksheet.

Move one screen down in a worksheet.

Excel keyboard shortcuts and function keys for Windows - Excel

Press

Shift+Tab

Up Arrow key

Down Arrow
key

Left Arrow key

Right Arrow key

Ctrl+arrow key

End, arrow key

Ctrl+End

Ctrl+Shift+End

Home+Scroll

Lock

Ctrl+Home

Page Down
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To do this

Move to the next sheet in a workbook.

Move one screen to the right in a worksheet.

Move one screen up in a worksheet.

Move one screen to the left in a worksheet.

Move to the previous sheet in a workbook.

Move one cell to the right in a worksheet. Or, in a protected
worksheet, move between unlocked cells.

Cycle through floating shapes, such as text boxes or images.

Press

Ctrl+Page
Down

Alt+Page Down

Page Up

Alt+Page Up

Ctrl+Page Up

Tab

Ctrl+Alt+5, and
then the Tab

key repeatedly
Exit the floating shape navigation and return to the normal navigation.  Esc
Top of Page
Keyboard shortcuts for formatting cells
To do this Press
Open the Format Cells dialog box. Ctrl+1
Format fonts in the Format Cells dialog box. Ctrl+Shift+F or

Ctrl+Shift+P

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...
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To do this

Edit the active cell and put the insertion point at the end of its
contents. Or, if editing is turned off for the cell, move the

insertion point into the formula bar. If editing a formula, toggle

Point mode off or on so you can use arrow keys to create a
reference.

Add or edit a cell comment.

Open the Insert dialog to insert blank cells.

Open the Delete dialog box to delete selected cells.

Enter the current time.

Enter the current date.

Switch between displaying cell values or formulas in the
worksheet.

Copy a formula from the cell above the active cell into the cell
or the Formula Bar.

Move the selected cells.

Copy the selected cells.

Paste content at the insertion point, replacing any selection.

Open the Paste Special dialog box.

ltalicize text or remove italic formatting.

Excel keyboard shortcuts and function keys for Windows - Excel

Press

F2

Shift+F2

Ctrl+Shift+Plus (+)

Ctrl+Minus (-)

Ctrl+Shift+colon ()

Ctrl+semi-colon ()

Ctrl+grave accent ()

Ctrl+apostrophe (')

Ctrl+X

Ctrl+C

Ctrl+V

Ctrl+Alt+V

Ctrl+1 or Ctrl+3

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=e...
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To do this

Bold text or remove bold formatting.

Underline text or remove underline.

Apply or remove strikethrough formatting.

Switch between hiding objects, displaying objects, and
displaying placeholders for objects.

Apply an outline border to the selected cells.

Remove the outline border from the selected cells.

Display or hide the outline symbols.

Use the Fill Down command to copy the contents and format of
the topmost cell of a selected range into the cells below.

Apply the General number format.

Apply the Currency format with two decimal places (negative
numbers in parentheses).

Apply the Percentage format with no decimal places.

Apply the Scientific number format with two decimal places.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢99-9b7213f0040f?ui=...

Press

Ctrl+B or Ctrl+2

Ctrl+U or Ctrl+4

Ctrl+5

Ctrl+6

Ctrl+Shift+ampersand
(&)

Ctrl+Shift+underline
@

Ctrl+8

Ctrl+D

Ctrl+Shift+tilde (~)

Ctrl+Shift+dollar sign
($)

Ctrl+Shift+percent (%)

Ctrl+Shift+caret (*)
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To do this

Apply the Date format with the day, month, and year.

Press

Ctrl+Shift+number
sign (#)

Apply the Time format with the hour and minute, and AM or Ctrl+Shift+at sign (@)

PM.

Apply the Number format with two decimal places, thousands ~ Ctrl+Shift+exclamation

separator, and minus sign (-) for negative values.

Open the Insert hyperlink dialog.

Check spelling in the active worksheet or selected range.

Display the Quick Analysis options for selected cells that
contain data.

Display the Create Table dialog box.

Top of Page

point ()

Ctrl+K

F7

Ctrl+Q

Ctrl+L or Ctrl+T

Keyboard shortcuts for making selections and performing actions

To do this

Select the entire worksheet.

Select the current and next sheet in a workbook.

Select the current and previous sheet in a workbook.

Press

Ctrl+A or
Ctrl+Shift+Spacebar

Ctrl+Shift+Page Down

Ctrl+Shift+Page Up

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=...  11/37



09/11/2017 Excel keyboard shortcuts and function keys for Windows - Excel

To do this Press
Extend the selection of cells by one cell. Shift+arrow key
Extend the selection of cells to the last nonblank cell in Ctrl+Shift+arrow key

the same column or row as the active cell, or if the next
cell is blank, to the next nonblank cell.

Turn extend mode on and use the arrow keys to extend a Turn extend mode on and

selection. Press again to turn off. use the arrow keys to extend
a selection. Press again to
turn off. F8

Add a non-adjacent cell or range to a selection of cells Shift+F8

by using the arrow keys.

Start a new line in the same cell. Alt+Enter

Fill the selected cell range with the current entry. Ctrl+Enter
Complete a cell entry and select the cell above. Shift+Enter

Select an entire column in a worksheet. Ctrl+Spacebar
Select an entire row in a worksheet. Shift+Spacebar
Select all objects on a worksheet when an object is Ctrl+Shift+Spacebar
selected.

Extend the selection of cells to the beginning of the Ctrl+Shift+Home
worksheet.
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To do this Press

Select the current region if the worksheet contains data.  Ctrl+A or

Press a second time to select the current region and its Ctrl+Shift+Spacebar
summary rows. Press a third time to select the entire

worksheet.

Select the current region around the active cell or select ~ Ctrl+Shift+asterisk (*)
an entire PivotTable report.

Select the first command on the menu when a menu or Home
submenu is visible.

Repeat the last command or action, if possible. Ctrl+Y
Undo the last action. Ctrl+Z
Top of Page

Keyboard shortcuts for working with data, functions, and the formula bar

To do this Press

Select an entire PivotTable report. Ctrl+Shift+asterisk
*)

Edit the active cell and put the insertion point at the end of its F2

contents. Or, if editing is turned off for the cell, move the insertion
point into the formula bar. If editing a formula, toggle Point mode
off or on so you can use arrow keys to create a reference.

Expand or collapse the formula bar. Ctrl+Shift+U

Cancel an entry in the cell or Formula Bar. Esc
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To do this

Complete an entry in the formula bar and select the cell below.

Move the cursor to the end of the text when in the formula bar.

Select all text in the formula bar from the cursor position to the end.

Calculate all worksheets in all open workbooks.

Calculate the active worksheet.

Calculate all worksheets in all open workbooks, regardless of
whether they have changed since the last calculation.

Check dependent formulas, and then calculate all cells in all open
workbooks, including cells not marked as needing to be calculated.

Display the menu or message for an Error Checking button.

Display the Function Arguments dialog box when the insertion point
is to the right of a function name in a formula.

Insert argument names and parentheses when the insertion point is
to the right of a function name in a formula.

Invoke Flash Fill to automatically recognize patterns in adjacent
columns and fill the current column

Cycle through all combinations of absolute and relative references
in a formula if a cell reference or range is selected.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢99-9b7213f0040f?ui=...

Excel keyboard shortcuts and function keys for Windows - Excel

Press

Enter

Ctrl+End

Ctrl+Shift+End

F9

Shift+F9

Ctrl+Alt+F9

Ctrl+Alt+Shift+F9

Alt+Shift+F10

Ctrl+A

Ctrl+Shift+A

Ctrl+E

F4
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To do this
Insert a function.

Copy the value from the cell above the active cell into the cell or the
formula bar.

Create an embedded chart of the data in the current range.

Create a chart of the data in the current range in a separate Chart
sheet.

Define a name to use in references.

Paste a name from the Paste Name dialog box (if names have been
defined in the workbook.

Move to the first field in the next record of a data form.
Create, run, edit, or delete a macro.
Open the Microsoft Visual Basic For Applications Editor.

Top of Page

Function keys

Key Description

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢99-9b7213f0040f?ui=...

Press

Shift+F3

Ctrl+Shift+straight
quotation mark (")

Alt+F1

F11

Alt+M, M, D

F3

Enter

Alt+F8

Alt+F11
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Key

F1

F2

F3

F4
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

F1 alone: displays the Excel Help task pane.
Ctrl+F1: displays or hides the ribbon.
Alt+F1: creates an embedded chart of the data in the current range.

Alt+Shift+F1: inserts a new worksheet.

F2 alone: edit the active cell and put the insertion point at the end of its
contents. Or, if editing is turned off for the cell, move the insertion point into the
formula bar. If editing a formula, toggle Point mode off or on so you can use
arrow keys to create a reference.

Shift+F2: adds or edits a cell comment.

Ctrl+F2: displays the print preview area on the Print tab in the Backstage view.

F3 alone: displays the Paste Name dialog box. Available only if names have been
defined in the workbook.

Shift+F3: displays the Insert Function dialog box.

F4 alone: repeats the last command or action, if possible.

When a cell reference or range is selected in a formula, F4 cycles through all the
various combinations of absolute and relative references.

Ctrl+F4: closes the selected workbook window.

Alt+F4: closes Excel.
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Key

F5

F6

F7

F8

Excel keyboard shortcuts and function keys for Windows - Excel

Description

F5 alone: displays the Go To dialog box.

Ctrl+F5: restores the window size of the selected workbook window.

F6 alone: switches between the worksheet, ribbon, task pane, and Zoom
controls. In a worksheet that has been split, F6 includes the split panes when
switching between panes and the ribbon area.

Shift+F6: switches between the worksheet, Zoom controls, task pane, and
ribbon.

Ctrl+F6: switches to the next workbook window when more than one workbook
window is open.

F7 alone: Opens the Spelling dialog box to check spelling in the active
worksheet or selected range.

Ctrl+F7: performs the Move command on the workbook window when it is not
maximized. Use the arrow keys to move the window, and when finished press
Enter, or Esc to cancel.

F8 alone: turns extend mode on or off. In extend mode, Extended Selection
appears in the status line, and the arrow keys extend the selection.

Shift+F8: enables you to add a nonadjacent cell or range to a selection of cells
by using the arrow keys.

Ctrl+F8: performs the Size command when a workbook is not maximized.

Alt+F8: displays the Macro dialog box to create, run, edit, or delete a macro.
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Key Description

F9 )
F9 alone: calculates all worksheets in all open workbooks.
Shift+F9: calculates the active worksheet.
Ctrl+Alt+F9: calculates all worksheets in all open workbooks, regardless of
whether they have changed since the last calculation.
Ctrl+Alt+Shift+F9: rechecks dependent formulas, and then calculates all cells in
all open workbooks, including cells not marked as needing to be calculated.
Ctrl+F9: minimizes a workbook window to an icon.

F10 . _ .
F10 alone: Turns key tips on or off. (Pressing Alt does the same thing.)
Shift+F10: displays the shortcut menu for a selected item.
Alt+Shift+F10: displays the menu or message for an Error Checking button.
Ctrl+F10: maximizes or restores the selected workbook window.

F11 ' _
F11 alone: Creates a chart of the data in the current range in a separate Chart
sheet.
Shift+F11: inserts a new worksheet.
Alt+F11: opens the Microsoft Visual Basic For Applications Editor, in which you
can create a macro by using Visual Basic for Applications (VBA).

F12 _ _

F12 alone: displays the Save As dialog box.

Top of Page

Other useful shortcut keys
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Key Description

Alt
= Displays the Key Tips (new shortcuts) on the ribbon.

For example,

Alt, W, P switches the worksheet to Page Layout view.
= Alt, W, L switches the worksheet to Normal view.

= Alt, W, | switches the worksheet to Page Break Preview view.

Arrow

Keys = Move one cell up, down, left, or right in a worksheet.

= Ctrl+Arrow Key moves to the edge of the current data region in a
worksheet.

= Shift+Arrow Key extends the selection of cells by one cell.

= Ctrl+Shift+Arrow Key extends the selection of cells to the last nonblank
cell in the same column or row as the active cell, or if the next cell is blank,
extends the selection to the next nonblank cell.

= Left Arrow or Right Arrow selects the tab to the left or right when the
ribbon is selected. When a submenu is open or selected, these arrow keys
switch between the main menu and the submenu. When a ribbon tab is
selected, these keys navigate the tab buttons.

= Down Arrow or Up Arrow selects the next or previous command when a
menu or submenu is open. When a ribbon tab is selected, these keys
navigate up or down the tab group.

= In a dialog box, arrow keys move between options in an open drop-down
list, or between options in a group of options.

= Down Arrow or Alt+Down Arrow opens a selected drop-down list.
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Key

Backspace

Delete

End
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Deletes one character to the left in the Formula Bar.
Also clears the content of the active cell.

In cell editing mode, it deletes the character to the left of the insertion
point.

Removes the cell contents (data and formulas) from selected cells without
affecting cell formats or comments.

In cell editing mode, it deletes the character to the right of the insertion
point.

End turns End mode on or off. In End mode, you can press an arrow key
to move to the next nonblank cell in the same column or row as the active
cell. End mode turns off automatically after pressing the arrow key. Make
sure to press End again before pressing the next arrow key. End mode is
shown in the status bar when it is on.

If the cells are blank, pressing End followed by an arrow key moves to the
last cell in the row or column.

End also selects the last command on the menu when a menu or
submenu is visible.

Ctrl+End moves to the last cell on a worksheet, to the lowest used row of
the rightmost used column. If the cursor is in the formula bar, Ctrl+End
moves the cursor to the end of the text.

Ctrl+Shift+End extends the selection of cells to the last used cell on the
worksheet (lower-right corner). If the cursor is in the formula bar,
Ctrl+Shift+End selects all text in the formula bar from the cursor position
to the end—this does not affect the height of the formula bar.
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Key

Enter

Esc

Home
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Completes a cell entry from the cell or the Formula Bar, and selects the
cell below (by default).

In a data form, it moves to the first field in the next record.

Opens a selected menu (press F10 to activate the menu bar) or performs
the action for a selected command.

In a dialog box, it performs the action for the default command button in
the dialog box (the button with the bold outline, often the OK button).

Alt+Enter starts a new line in the same cell.
Ctrl+Enter fills the selected cell range with the current entry.

Shift+Enter completes a cell entry and selects the cell above.

Cancels an entry in the cell or Formula Bar.
Closes an open menu or submenu, dialog box, or message window.

It also closes full screen mode when this mode has been applied, and
returns to normal screen mode to display the ribbon and status bar again.

Moves to the beginning of a row in a worksheet.

Moves to the cell in the upper-left corner of the window when Scroll Lock
is turned on.

Selects the first command on the menu when a menu or submenu is
visible.

Ctrl+Home moves to the beginning of a worksheet.

Ctrl+Shift+Home extends the selection of cells to the beginning of the
worksheet.

21/37



09/11/2017

Key

Page
Down

Page Up

Spacebar
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

= Moves one screen down in a worksheet.
= Alt+Page Down moves one screen to the right in a worksheet.
= Ctrl+Page Down moves to the next sheet in a workbook.

= Ctrl+Shift+Page Down selects the current and next sheet in a workbook.

= Moves one screen up in a worksheet.
= Alt+Page Up moves one screen to the left in a worksheet.
= Ctrl+Page Up moves to the previous sheet in a workbook.

= Ctrl+Shift+Page Up selects the current and previous sheet in a workbook.

= In a dialog box, performs the action for the selected button, or selects or
clears a check box.

= Ctrl+Spacebar selects an entire column in a worksheet.
= Shift+Spacebar selects an entire row in a worksheet.
= Ctrl+Shift+Spacebar selects the entire worksheet.

= If the worksheet contains data, Ctrl+Shift+Spacebar selects the current
region. Pressing Ctrl+Shift+Spacebar a second time selects the current
region and its summary rows. Pressing Ctrl+Shift+Spacebar a third time
selects the entire worksheet.

= When an object is selected, Ctrl+Shift+Spacebar selects all objects on a
worksheet.

= Alt+Spacebar displays the Control menu for the Excel window.
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Key Description

Tab
= Moves one cell to the right in a worksheet.

= Moves between unlocked cells in a protected worksheet.
= Moves to the next option or option group in a dialog box.

= Shift+Tab moves to the previous cell in a worksheet or the previous
option in a dialog box.

= Ctrl+Tab switches to the next tab in dialog box.

» Ctrl+Shift+Tab switches to the previous tab in a dialog box.

Top of Page

CTRL combination shortcut keys

Key Description
CTRL+PgUp Switches between worksheet tabs, from left-to-right.
CTRL+PgDn Switches between worksheet tabs, from right-to-left.

CTRL+SHIFT+( Unhides any hidden rows within the selection.

CTRL+SHIFT+) Unhides any hidden columns within the selection.

CTRL+SHIFT+&  Applies the outline border to the selected cells.

CTRL+SHIFT_ Removes the outline border from the selected cells.
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Key

CTRL+SHIFT+~

CTRL+SHIFT+$

CTRL+SHIFT+%

CTRL+SHIFT+A

CTRL+SHIFT+#

CTRL+SHIFT+@

CTRL+SHIFT +!

CTRL+SHIFT+*

CTRL+SHIFT+:

CTRL+SHIFT+"

CTRL+SHIFT+Plus
(+)
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Applies the General number format.

Applies the Currency format with two decimal places (negative
numbers in parentheses).

Applies the Percentage format with no decimal places.

Applies the Exponential number format with two decimal places.

Applies the Date format with the day, month, and year.

Applies the Time format with the hour and minute, and AM or PM.

Applies the Number format with two decimal places, thousands
separator, and minus sign (-) for negative values.

Selects the current region around the active cell (the data area
enclosed by blank rows and blank columns).
In a PivotTable, it selects the entire PivotTable report.

Enters the current time.

Copies the value from the cell above the active cell into the cell or
the Formula Bar.

Displays the Insert dialog box to insert blank cells.
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Key

CTRL+Minus (-)

CTRL+;

CTRL+"

CTRL+'

CTRL+1

CTRL+2

CTRL+3

CTRL+4

CTRL+5

CTRL+6

CTRL+8

CTRL+9

CTRL+0

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢99-9b7213f0040f?ui=...

Excel keyboard shortcuts and function keys for Windows - Excel

Description

Displays the Delete dialog box to delete the selected cells.

Enters the current date.

Alternates between displaying cell values and displaying formulas in
the worksheet.

Copies a formula from the cell above the active cell into the cell or
the Formula Bar.

Displays the Format Cells dialog box.

Applies or removes bold formatting.

Applies or removes italic formatting.

Applies or removes underlining.

Applies or removes strikethrough.

Alternates between hiding objects, displaying objects, and displaying
placeholders for objects.

Displays or hides the outline symbols.

Hides the selected rows.

Hides the selected columns.
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Key

CTRL+A

CTRL+B

CTRL+C

CTRL+D

CTRL+F

CTRL+G

CTRL+H
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Selects the entire worksheet.

If the worksheet contains data, CTRL+A selects the current region.
Pressing CTRL+A a second time selects the current region and its
summary rows. Pressing CTRL+A a third time selects the entire
worksheet.

When the insertion point is to the right of a function name in a
formula, displays the Function Arguments dialog box.

CTRL+SHIFT+A inserts the argument names and parentheses when
the insertion point is to the right of a function name in a formula.

Applies or removes bold formatting.

Copies the selected cells.

CTRL+C followed by another CTRL+C displays the Clipboard.

Uses the Fill Down command to copy the contents and format of
the topmost cell of a selected range into the cells below.

Displays the Find and Replace dialog box, with the Find tab
selected.

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find

action.

CTRL+SHIFT+F opens the Format Cells dialog box with the Font tab

selected.

Displays the Go To dialog box.

F5 also displays this dialog box.

Displays the Find and Replace dialog box, with the Replace tab
selected.
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Key

CTRL+I

CTRL+K

CTRL+N

CTRL+O

CTRL+P

CTRL+R

CTRL+S

CTRL+T

CTRL+U
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Applies or removes italic formatting.

Displays the Insert Hyperlink dialog box for new hyperlinks or the
Edit Hyperlink dialog box for selected existing hyperlinks.

Creates a new, blank workbook.

Displays the Open dialog box to open or find a file.

CTRL+SHIFT+0O selects all cells that contain comments.

Displays the Print dialog box.

CTRL+SHIFT+P opens the Format Cells dialog box with the Font tab
selected.

Uses the Fill Right command to copy the contents and format of the
leftmost cell of a selected range into the cells to the right.

Saves the active file with its current file name, location, and file
format.

Displays the Create Table dialog box.

Applies or removes underlining.

CTRL+SHIFT+U switches between expanding and collapsing of the
formula bar.
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Key

CTRL+V

CTRL+W
CTRL+X
CTRL+Y

CTRL+Z

Top of Page

Function keys

Key Description
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Inserts the contents of the Clipboard at the insertion point and
replaces any selection. Available only after you have cut or copied an
object, text, or cell contents.

CTRL+ALT+V displays the Paste Special dialog box. Available only
after you have cut or copied an object, text, or cell contents on a
worksheet or in another program.

Closes the selected workbook window.

Cuts the selected cells.

Repeats the last command or action, if possible.

Uses the Undo command to reverse the last command or to delete

the last entry that you typed.

CTRL+SHIFT+Z uses the Undo or Redo command to reverse or
restore the last automatic correction when AutoCorrect Smart Tags
are displayed.
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Key

F1

F2

F3

F4

F5
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Displays the Microsoft Office Excel Help task pane.

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent
user interface.

ALT+F1 creates a chart of the data in the current range.

ALT+SHIFT+F1 inserts a new worksheet.

Edits the active cell and positions the insertion point at the end of the cell contents.
It also moves the insertion point into the Formula Bar when editing in a cell is
turned off.

SHIFT+F2 adds or edits a cell comment.

CTRL+F2 displays the Print Preview window.

Displays the Paste Name dialog box.

SHIFT+F3 displays the Insert Function dialog box.

Repeats the last command or action, if possible.

When a cell reference or range is selected in a formula, F4 cycles through the
various combinations of absolute and relative references.

CTRL+F4 closes the selected workbook window.

Displays the Go To dialog box.

CTRL+F5 restores the window size of the selected workbook window.
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Key

F6

F7

F8

F9
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a
worksheet that has been split (View menu, Manage This Window, Freeze Panes,
Split Window command), F6 includes the split panes when switching between
panes and the Ribbon area.

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon.

CTRL+F6 switches to the next workbook window when more than one workbook
window is open.

Displays the Spelling dialog box to check spelling in the active worksheet or
selected range.

CTRL+F7 performs the Move command on the workbook window when it is not
maximized. Use the arrow keys to move the window, and when finished press
ENTER, or ESC to cancel.

Turns extend mode on or off. In extend mode, Extended Selection appears in the
status line, and the arrow keys extend the selection.

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by
using the arrow keys.

CTRL+F8 performs the Size command (on the Control menu for the workbook
window) when a workbook is not maximized.

ALT+F8 displays the Macro dialog box to create, run, edit, or delete a macro.

Calculates all worksheets in all open workbooks.
SHIFT+F9 calculates the active worksheet.

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of
whether they have changed since the last calculation.

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in
all open workbooks, including cells not marked as needing to be calculated.

CTRL+F9 minimizes a workbook window to an icon.
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Key Description

F10 Turns key tips on or off.
SHIFT+F10 displays the shortcut menu for a selected item.

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one
smart tag is present, it switches to the next smart tag and displays its menu or
message.

CTRL+F10 maximizes or restores the selected workbook window.

F11 Creates a chart of the data in the current range.
SHIFT+F11 inserts a new worksheet.
ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro
by using Visual Basic for Applications (VBA).

F12 Displays the Save As dialog box.

Top of Page

Other useful shortcuts

Key Description
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Key

ARROW
KEYS

BACKSPACE

DELETE
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Excel keyboard shortcuts and function keys for Windows - Excel

Description

Move one cell up, down, left, or right in a worksheet.

CTRL+ARROW KEY moves to the edge of the current data region in a
worksheet.

SHIFT+ARROW KEY extends the selection of cells by one cell.

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last
nonblank cell in the same column or row as the active cell, or if the next
cell is blank, extends the selection to the next nonblank cell.

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the
Ribbon is selected. When a submenu is open or selected, these arrow keys
switch between the main menu and the submenu. When a Ribbon tab is
selected, these keys navigate the tab buttons.

DOWN ARROW or UP ARROW selects the next or previous command when
a menu or submenu is open. When a Ribbon tab is selected, these keys
navigate up or down the tab group.

In a dialog box, arrow keys move between options in an open drop-down
list, or between options in a group of options.

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list.

Deletes one character to the left in the Formula Bar.
Also clears the content of the active cell.

In cell editing mode, it deletes the character to the left of the insertion
point.

Removes the cell contents (data and formulas) from selected cells without
affecting cell formats or comments.

In cell editing mode, it deletes the character to the right of the insertion
point.
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Key

END

ENTER

ESC

Excel keyboard shortcuts and function keys for Windows - Excel

Description

Moves to the cell in the lower-right corner of the window when SCROLL
LOCK is turned on.

Also selects the last command on the menu when a menu or submenu is
visible.

CTRL+END moves to the last cell on a worksheet, in the lowest used row of
the rightmost used column. If the cursor is in the formula bar, CTRL+END
moves the cursor to the end of the text.

CTRL+SHIFT+END extends the selection of cells to the last used cell on the
worksheet (lower-right corner). If the cursor is in the formula bar,
CTRL+SHIFT+END selects all text in the formula bar from the cursor
position to the end—this does not affect the height of the formula bar.

Completes a cell entry from the cell or the Formula Bar, and selects the cell
below (by default).

In a data form, it moves to the first field in the next record.

Opens a selected menu (press F10 to activate the menu bar) or performs
the action for a selected command.

In a dialog box, it performs the action for the default command button in
the dialog box (the button with the bold outline, often the OK button).

ALT+ENTER starts a new line in the same cell.
CTRL+ENTER fills the selected cell range with the current entry.

SHIFT+ENTER completes a cell entry and selects the cell above.

Cancels an entry in the cell or Formula Bar.
Closes an open menu or submenu, dialog box, or message window.

It also closes full screen mode when this mode has been applied, and
returns to normal screen mode to display the Ribbon and status bar again.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=...  33/37
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Key Description

HOME Moves to the beginning of a row in a worksheet.

Moves to the cell in the upper-left corner of the window when SCROLL
LOCK is turned on.

Selects the first command on the menu when a menu or submenu is
visible.

CTRL+HOME moves to the beginning of a worksheet.

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the
worksheet.

PAGE Moves one screen down in a worksheet.

DOWN
ALT+PAGE DOWN moves one screen to the right in a worksheet.
CTRL+PAGE DOWN moves to the next sheet in a workbook.

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a
workbook.

PAGE UP Moves one screen up in a worksheet.
ALT+PAGE UP moves one screen to the left in a worksheet.
CTRL+PAGE UP moves to the previous sheet in a workbook.

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a
workbook.

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9¢c99-9b7213f0040f?ui=...  34/37
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Key Description

SPACEBAR In a dialog box, performs the action for the selected button, or selects or
clears a check box.

CTRL+SPACEBAR selects an entire column in a worksheet.
SHIFT+SPACEBAR selects an entire row in a worksheet.

CTRL+SHIFT+SPACEBAR selects the entire worksheet.

= If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the
current region. Pressing CTRL+SHIFT+SPACEBAR a second time selects
the current region and its summary rows. Pressing
CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet.

= When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects
on a worksheet.

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel
window.

TAB Moves one cell to the right in a worksheet.
Moves between unlocked cells in a protected worksheet.
Moves to the next option or option group in a dialog box.

SHIFT+TAB moves to the previous cell in a worksheet or the previous
option in a dialog box.

CTRL+TAB switches to the next tab in dialog box.

CTRL+SHIFT+TAB switches to the previous tab in a dialog box.

Top of Page

NOTE: This feature is only available if you have an Office 365 subscription. If you are an Office 365
subscriber, make sure you have the latest version of Office.

Try Office 365
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Need more help?

You can always ask an expert in the Excel Tech Community, get support in the Answers
community, or suggest a new feature or improvement on Excel User Voice.

See also

Keyboard shortcuts in Excel 2016 for Mac
Overview of formulas in Excel

How to avoid broken formulas

Detect errors in formulas

Excel functions (alphabetical)

Excel functions (by category)

Basic tasks using a screen reader with Excel

Learn how to navigate in Excel using accessible features

Technical support for customers with disabilities

Microsoft wants to provide the best possible experience for all our customers. If you have a
disability or questions related to accessibility, please contact the Microsoft Disability
Answer Desk for technical assistance. The Disability Answer Desk support team is trained in
using many popular assistive technologies and can offer assistance in English, Spanish,
French, and American Sign Language. Please go to the Microsoft Disability Answer Desk
site to find out the contact details for your region.

If you are a government, commercial, or enterprise user, please contact the enterprise
Disability Answer Desk.

£ Jin IS
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Top 10 Search Engine Tips

This article is also available as a PDF download.

1: Use unique, specific terms

It is simply amazing how many Web pages are returned when performing a
search. You might guess that the terms blue dolphin are relatively specialized.
A Google search of those terms returned 2,440,000 results! To reduce the
number of pages returned, use unigue terms that are specific to the subject
you are researching.

2: Use the minus operator (-) to narrow the search

How many times have you searched for a term and had the search engine
return something totally unexpected? Terms with multiple meanings can return
a lot of unwanted results. The rarely used but powerful minus operator,
equivalent to a Boolean NOT, can remove many unwanted results. For
example, when searching for the insect caterpillar, references to the company
Caterpillar, Inc. will also be returned. Use Caterpillar -Inc to exclude
references to the company or Caterpillar -Inc -Cat to further refine the search.

3: Use quotation marks for exact phrases

| often remember parts of phrases | have seen on a Web page or part of a
quotation | want to track down. Using quotation marks around a phrase will
return only those exact words in that order. It's one of the best ways to limit
the pages returned. Example: "Be nice to nerds".Of course, you must have the
phrase exactly right — and if your memory is as good as mine, that can be
problematic.

4: Don't use common words and punctuation

Common terms like a and the are called stop words and are usually ignored.
Punctuation is also typically ignored. But there are exceptions. Common
words and punctuation marks should be used when searching for a specific
phrase inside quotes. There are cases when common words like the are
significant. For instance, Raven and The Raven return entirely different
results.

5: Capitalization

Most search engines do not distinguish between uppercase and lowercase,
even within quotation marks. The following are all equivalent:

« technology
o Technology
« TECHNOLOGY



« "technology"
"Technology"

6: Drop the suffixes

It's usually best to enter the base word so that you don't exclude relevant
pages. For example, bird and not birds, walk and not walked. One exception is
if you are looking for sites that focus on the act of walking, enter the whole
term walking.

7: Maximize AutoComplete

Ordering search terms from general to specific in the search box will display
helpful results in a drop-down list and is the most efficient way to use
AutoComplete. Selecting the appropriate item as it appears will save time
typing. You have several choices for how the AutoComplete feature works:

Use Google AutoComplete. The standard Google start page will display a
drop-down list of suggestions supplied by the Google search engine. This
option can be a handy way to discover similar, related searches. For example,
typing in Tucson fast will not only bring up the suggestion Tucson fast food but
also Tucson fast food coupons. Use browser AutoComplete. Use

this Google start page to disable the Google AutoComplete feature and
display a list of your previous searches in a drop-down box. | find this
particularly useful when I've made dozens of searches in the past for a
particular item. The browser's AutoComplete feature must be turned on for this
option to work. Click one of these links for instructions detailing how to turn
AutoComplete on or off in |.E. and Firefox.

Examples:

« Visual Basic statement case
o Visual Basic statement for
« Visual Basic call

8: Customize your searches

There are several other less well known ways to limit the number of results
returned and reduce your search time:

« The plus operator (+): As mentioned above, stop words are typically
ignored by the search engine. The plus operator tells the search engine to
include those words in the result set. Example: tall +and short will return
results that include the word and.

o The tilde operator (~): Include a tilde in front of a word to return results
that include synonyms. The tilde operator does not work well for all terms
and sometimes not at all. A search for ~CSS includes the



synonym style and returns fashion related style pages —not exactly what
someone searching for CSS wants. Examples: ~HTML to get results

for HTML with synonyms; ~HTML -HTMLto get synonyms only for HTML.
The wildcard operator (*): Google calls it the fill in the blank operator. For
example, amusement * will return pages with amusement and any other
term(s) the Google search engine deems relevant. You can't use wildcards
for parts of words. So for example, amusement p* is invalid.

The OR operator (OR) or (|): Use this operator to return results with either
of two terms. For example happy joy will return pages with

both happy and joy, while happy | joy will return pages with

either happy or joy.

Numeric ranges: You can refine searches that use numeric terms by
returning a specific range, but you must supply the unit of measurement.
Examples: Windows XP 2003..2005, PC $700 $800.

Site search: Many Web sites have their own site search feature, but you
may find that Google site search will return more pages. When doing
research, it's best to go directly to the source, and site search is a great
way to do that. Example: site:www.intel.com rapid storage technology.
Related sites: For example, related:www.youtube.com can be used to find
sites similar to YouTube.

Change your preferences: Search preferences can be set globally by
clicking on the gear icon in the upper-right corner and selecting Search
Settings. | like to change the Number Of Results option to 100 to reduce
total search time.

Forums-only search: Under the Google logo on the left side of the search
result page, click More | Discussions or go to Google Groups. Forums are
great places to look for solutions to technical problems.

Advanced searches: Click the Advanced Search button by the search box
on the Google start or results page to refine your search by date, country,
amount, language, or other criteria.

Wonder Wheel: The Google Wonder Wheel can visually assist you as you
refine your search from general to specific. Here's how to use this tool:

. Click on More Search Tools | Wonder Wheel in the lower-left section of the
screen (Figure A) to load the Wonder Wheel page.
. Click on dbms tutorial (Figure B).

Figure A
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As you can see in Figure C, Google now displays two wheels showing the
DBMS and dbms tutorial Wonder Wheels, with the results for doms tutorial on
the right side of the page. You can continue drilling down the tree to further
narrow your search. Click the Close button at the top of the results to remove
the Wonder Wheel(s).

Figure C
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9: Use browser history

Many times, | will be researching an item and scanning through dozens of
pages when | suddenly remember something | had originally dismissed as
being irrelevant. How do you quickly go back to that Web site? You can try to
remember the exact words used for the search and then scan the results for
the right site, but there is an easier way. If you can remember the general date
and time of the search you can look through the browser history to find the
Web page.

10: Set a time limit — then change tactics

Sometimes, you never can find what you are looking for. Start an internal
clock, and when a certain amount of time has elapsed without results, stop
beating your head against the wall. It's time to try something else:

« Use a different search engine, like Yahoo!, Bing, Startpage, or Lycos.
o Ask a peer.

« Call support.

« Ask a question in the appropriate forum.




« Use search experts who can find the answer for you.

The bottom line

A tool is only as useful as the typing fingers wielding it. Remember that old
acronym GIGO, garbage in, garbage out? Search engines will try to place the
most relevant results at the top of the list, but if your search terms are too
broad or ambiguous, the results will not be helpful. It is your responsibility to
learn how to make your searches both fast and effective.

The Internet is the great equalizer for those who know how to use it efficiently.
Anyone can now easily find facts using a search engine instead of dredging
them from the gray matter dungeon — assuming they know a few basic tricks.
Never underestimate the power of a skilled search expert.



Top 10 free PC programs everyone should
have
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open source projects available, many of them better than any

| [ There are millions of free and

commercially available product. Below is a short listing of what we
think are the best out there, broken down into ten categories.

Antivirus and malware protection

Most PC users realize that they need protection on their computer or may
have an installed antivirus program from their computer manufacturer.
What most don't realize is that there are free programs that are just as
good and in some cases better than the commercial products. Below are
our recommendations.

Antivirus program: Avast!

Malware and Spyware protection: Malwarebytes

Backup solutions

There are dozens of free and commercially available backup programs for
computers. Unfortunately, many of those backups are stored locally,
meaning if your house were to catch fire, get robbed, or if you lost your
backup discs, all your data would be lost. To avoid loss of important data,
we suggest users use online backup services.

Online backup solution: Mozy or Dropbox

Browsers




Although Microsoft Internet Explorer comes pre-installed on Windows
computers. There are several excellent free alternatives that everyone
should try. These free alternatives can often be faster, have more
options, and in many cases be more secure than Internet Explorer.

Internet Browser: Mozilla Firefox or Google Chrome
Compression utility

When downloading files on the Internet you'll eventually encounter a .zip,
.rar, or other compressed file. Dealing with these files can be easy with
our below free file compression utility.

File compression utility: 7-Zip

Disc ripper and creation utility

Creating an audio or data CD/DVD, ripping the data from an audio CD, or
creating a CD from a .1SO file can also be done freely using our below
free recommendation.

CD burner utility: CDBurnerXP

E-mail

E-mail is yet another service that can be done freely. Most users today
use online e-mail solutions like the one listed below. However, for those
still using an e-mail client such as Microsoft Outlook we strongly suggest
one or both of the below suggestions.

E-mail client: Mozilla Thunderbird

Online e-mail: Gmail

FTP, SFTP, and SSH Utility

Users who maintain their own web page or need to upload or download
files to or from a server have to use an FTP utility or an SSH client. There
are many commercial programs capable of doing this but our below free
recommendations beats them all.

FTP client: Filezilla

SSH client: MobaXterm and Putty

Image editor, paint program, and picture organizer



There are many great free solutions for editing, creating, and organizing
your images on your computer. Many of the programs capable of doing
these tasks can be several hundred dollars, but all of the below programs
are completely free.

Image editor: GIMP

Paint program: Paint.net

Picture organizer: Google Photos
Multimedia

There are dozens of different multimedia programs with different
capabilities and limitations. Below are our top free multimedia programs
for watching video files and recording audio.

Audio editing and creating tool: Audacity

Video and DVD Player: VLC and MPC-HC

Office Suite

An Office suite such as Microsoft Office is often one of the most expensive
programs that a user can install on their computer. Why install these
expensive programs when there are free solutions that are just as good.
Office suite: OpenOffice

Notepad and Source code editor: Notepad++



What are the F1 through F12 keys?

Commonly known as function keys on a computer keyboard, F1
through F12 may have a variety of different uses or no use at all.
The operating system installed on the computer and the software
program that is currently open dictates how each of these keys
operate. A program is capable of not only using each of the function
keys, but also combining the function keys with the Alt or Ctrl key.
For example, Microsoft Windows users can press Alt+F4 to close the

currently active program.

Note: Some keyboards' F1-F12 keys include additional functionality when
used in combination with the Fn key, which is usually located near Ctrl.
For example, if the F11 key has a blue "Stop" sign under it, pressing Fn +
F11 will stop the music you're listening too. The additional functions
available with the use of the Fn key will differ depending on the brand of
keyboard being used. Please check your computer's documentation or
manufacturer's website for specific details on which features are available
on your keyboard.

Tip: Some computers may automatically enable the Fn key for accessing
the special functions on the F1 through F12 keys. You may be able to turn

off the Fn key by accessing the keyboard settings in the Control Panel.

Note: If your keyboard does not have a row of function keys, they are
probably set up as secondary functions on other keys, similar to the Fn
situation outlined above. Some laptop keyboards are set up this way to
save space.

Below is a listing of some of the more common functions of the functions
keys for Microsoft Windows and Microsoft applications, as well as some
for macOS. As mentioned above, not all programs support these function
keys and the function keys on your keyboard may perform different tasks

then those mentioned below.




Tip: If you are looking for specific shortcut keys and function key

examples, please visit our shortcut keys page.

F1

F3

F5

Almost always used as the help key, almost every program opens a help screen when
this key is pressed.

Enter CMOS Setup.

Windows Key + F1 would open the Microsoft Windows help and support center.
Open the Task Pane.

In Windows renames a highlighted icon, file, or folder in all versions of Windows.
In Microsoft Excel edits the current active cell.

Alt+Ctrl+F2 opens document window in Microsoft Word.

Ctrl+F2 displays the print preview window in Microsoft Word.

Quickly rename a selected file or folder.

Enter CMOS Setup.

Often opens a search feature for many programs including Microsoft Windows when at
the Windows Desktop.

In MS-DOS or Windows command line F3 will repeat the last command.

Shift+F3 will change the text in Microsoft Word from upper to lower case or a capital
letter at the beginning of every word.

Windows Key + F3 opens the Advanced find window in Microsoft Outlook.

In Windows Explorer start the search function.

Open Mission Control on an Apple computer running macOS X.

Open find window in Windows 95 to XP.

Open the address bar in Windows Explorer and Internet Explorer.

Repeat the last action performed (Word 2000+).

Alt+F4 closes the program window currently active in Microsoft Windows.
Ctrl+F4 closes the open window within the current active window in Microsoft
Windows.

In all modern Internet browsers, pressing F5 will refresh or reload the page or
document window.

Ctrl+F5 forces a complete refresh of the web page, clearing the cache and downloading
all contents of the page again

Refresh the list of contents in a folder.

Open the find, replace, and go to window in Microsoft Word.

Starts a slideshow in PowerPoint.

Move the cursor to the address bar in Internet Explorer, Mozilla Firefox, and most other
Internet browsers.
Ctrl+Shift+F6 opens to another open Microsoft Word document.



F9

Reduce laptop speaker volume (on some laptops).

Commonly used to spell check and grammar check a document in Microsoft programs
such as Microsoft Word, Outlook, etc.

Shift+F7 runs a Thesaurus check on the word highlighted.

Turns on Caret browsing in Mozilla Firefox.

Increase laptop speaker volume (on some laptops).

Function key used to enter the Windows startup menu, commonly used to access
Windows Safe Mode.

Used by some computers to access the Windows recovery system, but may require a
Windows installation CD.

Displays a thumbnail image for all workspaces in macOS.

Refresh document in Microsoft Word.

Send and receive e-mail in Microsoft Outlook.

Opens the Measurements toolbar in Quark 5.0.

Reduce laptop screen brightness (on some laptops).

With macOS 10.3 or later, displays a thumbnail for each window in a single workspace.
Using the Fn key and F9 at the same time opens Mission Control on an Apple computer
running macOS X.

In Microsoft Windows activates the menu bar of an open application.

Shift+F10 is the same as right-clicking on a highlighted icon, file, or Internet link.
Access the hidden recovery partition on Compaq, HP, and Sony computers.
Enter CMOS Setup on some computers.

Increase laptop screen brightness (on some laptops)

With macOS 10.3 or later, shows all open Windows for the active program.

Enter and exit fullscreen mode in all modern Internet browsers.

Ctrl+F11 as computer is starting to access the hidden recovery partition on many Dell
computers.

Access the hidden recovery partition on eMachines, Gateway, and Lenovo computers.
With macOS 10.4 or later, hides all open windows and shows the Desktop.

Open the Save as window in Microsoft Word.

Ctrl+F12 opens a document In Word.

Shift+F12 saves the Microsoft Word document (like Ctrl+S).

Ctrl+Shift+F12 prints a document in Microsoft Word.

Preview a page in Microsoft Expression Web.

Open Firebug or browser debug tool.

With an Apple running macOS 10.4 or later, F12 shows or hides the Dashboard.



e Access the list of bootable devices on a computer at startup, allowing you to select a
different device to boot from (hard drive, CD or DVD drive, floppy drive, USB drive, and
network).

F13 - F15

e Onnewer Apple keyboards the F13, F14, and F15 may be shown in place of the Print
Screen key, Scroll lock key, and Pause key.

F16 - F19

e Onnewer Apple keyboards the F16, F17, F18, and F19 keys are above the number pad.

F13 - F24

e Early IBM computers also had keyboards with F13 through F24 keys. However, because
these keyboards are no longer used, they are not listed on this page.

Additional information

Computer keyboard keys and explanations.
Computer keyboard shortcuts

See the function keys definition for further information about this term and related terms.
What to do if the function keys are not working
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ASCII Character Codes Table & Cheat Sheet

Extended ASCII

Special Chars

9

10
13
32
33
34
35
36
37
38
39
40
a1
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
91
92
93
94
95
96
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\t (Tab)
\n (NL)
\r (CR)
Space

¥ Nt A~ =

+

-

© 0 N O U1 A W N K ON !

A ~=

> Mm@ N Y

Upper Case

65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90

N<Xg<c-HwnpxovozzrxXx4“-"ITeoeomTmoow?p

Lower Case

97

98

99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122

= I ™ 0 Q 0

— x‘-h

N< X g<c™®nh =™ aoaT 0 3 3

128
129
130
131
132

€
O

f

144

133 ...
134 ¢t
135 #

136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159
160
161
162
163
164
165
166
167
168
169

%00

A

‘DjN<LH

w

144

v

-<:N<38

K x h &6 =

W

&#128;
&#129;
&#130;
&#131;
&#132;
&#133;
&#134;
&+#135;
&+#136;
&+#137;
&+#138;
&+#139;
&#140;
&+#141;
&#142;
&#143;
&#144;
&+#145;
&#146;
&#147;
&#148;
&#149;
&+#150;
&#151;
&#152;
&#153;
&#154;
&#155;
&#156;
&#157;
&#158;
&#159;
&#160;
&#161;
&#162;
&#163;
&#164;
&#165;
&#166;
&#167;
&#168;
&#169;

13
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170 a  &#170;
171 «  &#171;
172 = &#172;

173 &#173;
174 ® &#174;
175~ &#175;

176 ©  &#176;
177 £  &#177;
178 2 &#178;
179 3 &#179;
180 °~ &#180;
181 p  &#181;
182 9 &#182;
183 - &#183;
184 &#184;
185 1+ &#185;
186 © &#186;
187 » &#187;
188 12 &#188;
189 1> &#189;
190 34 &#190;

191 &  &#191;
192 A &#192;
193 A &#193;
194 A &#194;
195 A &#195;
196 A &#196;
197 A &#197;
198 E &#198;
199 ¢ &#199;
200 E  &#200;
201 E  &#201;
202 E  &#202;
203 E  &#203;
204 I &#204;
205 T &#205;
206 I &+#206;
207 I &#207;
208 B &#208;
209 N &#209;
210 O  &#210;
211 6 &#211;
212 6  &#212;
213 6 &#213;
214 O &#214;
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215
216
217
218
219
220
221
222
223
224
225
226
227
228
229
230
231
232
233
234
235
236
237
238
239
240
241
242
243
244
245
246
247
248
249
250
251
252
253
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&#215;
&#216;
&#217;
&#218;
&#219;
&#220;
&#221;
&#222;
&#223;
&#224;
&#225;
&#226;
&#227;
&#228;
&#229;
&+#230;
&#231;
&#232;
&#233;
&#234;
&#235;
&#236;
&#237;
&#238;
&#239;
&#240;
&#241;
&#242;
&#243;
&#244;
&#245;
&#246;
&#247;
&#248;
&#249;
&#250;
&#251;
&#252;
&#253;
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